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Printer Components
Base configuration
Printer components, right-front view

1. Top Output Tray
(output delivered facedown)

2. Top cover

3. Front panel

4. Power switch

5. Duplex Unit (optional)
(shown closed)

6. Duplex Unit release

7. Tray 1

8. Paper level gauge

9. Top cover release

10. Multi-Purpose Tray (MPT)

11. Multi-Purpose Tray (MPT) release

12. Door A

12

3

4

5

6

7
8

9

10

11

12
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Printer components, left-rear view

1. Ethernet UTP connector

2. USB connector

3. Parallel connector

4. Power cord receptacle

5. Left Side Output Tray (shown closed) (output delivered faceup)

Side view

1. Left Side Output Tray (shown open) (output delivered faceup)

1

2

3

4 5

7300-31
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Internal Components
Internal components, right-front view

1. Fuser

2. Transfer Unit

3. Toner Cartridge

4. Imaging Unit

7300-30

1

2

3

4

3

4
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Printer options

Optional paper trays
The configuration shown here includes the maximum number of trays. The Lower Tray Configurations 
section in the Setup Guide on the Interactive Documentation CD-ROM shows every available 
configuration.

1. Tray 2 (550-sheet feeder)

2. Tray 3 (550-sheet feeder)

3. Tray 4 (550-sheet feeder)

4. Tray 5 (550-sheet feeder)

5. 550-Sheet Feeder Option -  One or two additional trays that can hold 550 sheets each.

6. Right Door B

7. Right Door C

8. Right Door D

9. Right Door E

10. 1650-Sheet High-Capacity Feeder Option - Stack of three trays that can connect to Tray 1 or 
Tray 2.

7300-32
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You can attach the following (see the Lower Tray Configurations section in the Setup Guide on the 
Interactive Documentation CD-ROM):

� One 550-Sheet Feeder or 1650 Sheet High-Capacity Feeder. 

� Two 550-Sheet Feeders 

� A combination of one 550-Sheet Feeder and one 1650-Sheet High-Capacity Feeder. 

Optional duplex unit

1. Duplex Unit (shown pulled out on top of Tray 1)

� The duplex unit attaches to the top of Tray 1. 

� You must pull open Tray 1 and the duplex unit together.

Ordering options

To order any of the options shown in this section, see www.xerox.com/officeprinting/7300supplies.

7300-33

1

http://www.xerox.com/officeprinting/7300supplies
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Front Panel Usage
Front panel description
The front panel: 

� Displays the printer�s operating status (Printing, Ready to Print, etc.).

� Alerts you to load paper, replace consumables, and clear jams.

� Enables you to access tools and information pages to help troubleshoot problems.

� Enables you to change printer settings and network settings; driver settings override the printer�s 
front panel settings.

� Enables you to print Secure Print, Proof Print, and Saved Print jobs that you have stored on the 
printer�s optional hard disk. For more information, see the printer driver help or the Driver 
Features section of the Features Guide on the Interactive Documentation CD-ROM. 

 1 Status indicator light
Blinks = Printer is busy. 
Green = OK
Yellow = Warning, continues to function.
Red = Problem, stops printing.

5 Up Arrow key

 2 Graphic front panel display 6 Down Arrow key 

 3 Cancel key 7 OK key

 4 Back key 8 Information key - provides additional details.

OK

7300-27

P h a s e r  7 3 0 0

1 2

3

4

5

6 7 8
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Menu Map
For a complete list of printable pages, print the Menu Map:

1. Select Menus on the front panel and press the OK key.

2. Select Print Menu Map and press the OK key.

Accessing printable pages
Access these pages from the Printable Pages Menu:

1. At the front panel, scroll to the Printable Pages Menu using the Down Arrow or 
Up Arrow key and press the OK key.

2. Scroll to the desired printable page (such as Paper Tips) using the Down Arrow or Up Arrow 
key and press the OK key.

Error Messages
When there is a problem with the printer, the front panel display (1) shows the error message. Press the 
i button (2) for more information about the error message and ways to solve the problem.
 

OK

7300-90

P h a s e r 7 3 0 0

1 2
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Supplies Info Menu
    Same as above 

Print Menu Map
Prints this page

Supplies Info Menu
Provides supplies 
usage information

Printer Setup Menu
Provides tools to set 
up the default printer 
behavior

Printable Pages Menu
Provides a list of all of 
the pages stored in 
the printer for easy 
printing

Support Menu
Provides tools and 
information on 
troubleshooting the 
printer

Connection Setup 
Menu

Provides tools to help 
connect the printer to 
a network

Print Supplies Page
Print Paper Tips Page
Cyan Toner Life
Magenta Toner Life

Yellow Toner Life
Black Toner Life
Cyan Imaging Unit Life
Magenta Imaging Unit Life

Yellow Imaging Unit Life
Black Imaging Unit Life
Transfer Unit Life
Fuser Life

Total Print Count

Print Connection Setup Page
Print Configuration Pages
TCP/IP Address Menu*
TCP/IP*

CentreWare IS*
EtherTalk*
Netware*
Set IPX Frame Type*

IPP*
SLP*
SSDP* 
Set Ethernet Speed*

Parallel Setup Menu
USB Setup Menu
Reset Connection Setup

Print Configuration Pages
Set Front Panel Language
Tray Setup Menu

MPT Setup Menu
Tray 1 Setup Menu
Set Tray 2 Paper Type 
Set Tray 3 Paper Type
Set Tray 4 Paper Type
Set Tray 5 Paper Type
Set Custom Units
Special Paper Setup Menu

Set Front Panel Intensity
Set Front Panel Contrast
PostScript Error Info
Set Power Saver Timeout
Set Load Paper Timeout
Job Defaults Menu

Reset Printer Setup �
Menu 

Reset Printer Setup NOW
Power Saver
Metric Defaults

Set Font Number
Set Pitch
Set Point Size
Select Symbol Set
Set Orientation
Set Form Length
Line Termination
�

Proof Print Jobs
Saved Print Jobs
Secure Print Jobs
Graphics Demonstration
Office Demonstration
2-Sided Demonstration
Print PCL Font List
Print PostScript Font List
Print Usage Profile
Print Moving Guide
Print Configuration Pages

Print CMYK Sampler Pages
Print RGB Sampler Pages
Print Help Guide
Print Supplies Page
Print Diagnostic Pages
Print-Quality Tips Page
Print Paper Tips Page
Print Connection Setup Page
Print Startup Page
Print Menu Map
Service Pages Menu

Print Calibrate Margins Page
Print Calibrate Colors Pages
Print Color Test Pages
Print Solid Fill Pages
Print Repeating Defects Page
Print NetWare Start Log*
Print NetWare Runtime Log*
Print TCP/IP Start Log*
Print TCP/IP Runtime Log*
Print AppleTalk Start Log*
Print AppleTalk Runtime Log*
Print Hardware Start Log*

Items marked with an * do not 
appear on the 7300B

Optional Features Legend�
 - Requires -

1  Hard Drive
2  Trays
3  Duplex

Print Help Guide
Printer Identification

Model
Printer Name
Print Server*
IP Address*
Select for Installation*
Serial #
Activation Date

Improve Print Quality? Network Questions?*

Print Connection Setup Page
Print Configuration Pages
Print NetWare Start Log
Print NetWare Runtime Log
Print TCP/IP Start Log
Print TCP/IP Runtime Log
Print AppleTalk Start Log
Print AppleTalk Runtime Log
Print Hardware Start Log
PostScript Error Info
Reset Connection Setup

Usage Profile Menu

Resolve Paper Jams?

Print Paper Tips Page
Online Jam Prevention

Service Tools Menu

Reset NVRAM
Fault History

Intelligent Ready
Calibrate Colors Menu
Startup Page

Print Diagnostic Pages
Print Color Test Pages
Print Solid Fill Pages
Print Paper Tips Page
Print Supplies Page
Print-Quality Tips Page
Remove Print Smears
Calibrate Colors Menu
Calibrate Margins Menu
Reset Calibrations

Print Usage Profile
Email Full Report*
Email Job Report*

3

2
2
2
2

Set Paper Source
Set Paper Destination
Job Offset
Set 2-Sided Printing
Set Print-Quality Mode
Image Smoothing
Set TekColor Correction
PCL Job Defaults Menu
Reset Job Defaults

Note: All Printable Pages are in red.

3

Accessible Front Panel 

PHASER® 7300 COLOR PRINTER
Menu Map



Phaser® 7300 Color Printer

Copyright © 2002 Xerox Corporation. All Rights Reserved. 8

Printing
When sending a job to the printer, select special features in the printer driver.

� Windows - Use a PostScript driver with the Phaser 7300 PPD file or the PCL5c driver.

� Macintosh - Use the LaserWriter 8 driver with the Phaser 7300 PPD file or the MacOS X driver. 

Features available with these drivers include:

� Print-quality modes

� TekColorTM corrections

� Secure print jobs

� Proof print jobs

� Saved print jobs

� Separation pages

� Multiple pages on a single sheet

� Booklet printing

� Negative and mirror images

� Scaling

� Auto Fit

� Watermarks

� Image smoothing

� Custom paper sizes

� Cover pages
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Driver Features 
Print-quality modes   
You can choose between different print quality modes to obtain the best combination of speed and print 
quality for your job.

* Approximate number of pages per minute (ppm) does not include I/O or image processing time. Two-sided (duplex) printing 
has a slower speed.

Specify the print-quality mode in a supported driver:

� Windows 95 / Windows 98 / Windows Me PostScript driver:
On the Setup tab, select a print quality by moving the slider.

� Windows NT / Windows 2000 / Windows XP PostScript driver:
On the Paper/Quality tab, select a print quality by moving the slider.

� MacOS 8 / MacOS 9 driver:
In the Print dialog box, click on General, select Print Quality from the pull-down menu, then 
select the desired mode for Quality.

� MacOS X (version 10.1 and higher) driver:
In the Print dialog box, select the Printer Features pull-down menu, then select the 
Print Quality/Color tab. Select the desired mode for Quality. 

Print-quality mode Maximum speed for letter and 
A4 size paper*

Standard    
� General purpose mode for high-speed color printing
� Produces crisp, bright prints
� Suitable for most office documents and images
� Prints at 600 x 600 dpi

Plain paper:
� 30 ppm color 
� 37 ppm black-and-white
Specialty papers:
� 10 ppm color 
� 15 ppm black-and-white

Enhanced   
� Highest-quality color prints
� Richest color and near-photographic detail
� Prints at 600 x 2400 dpi

Plain paper
� Up to 16 ppm color

Draft    
� Lighter toner usage than standard mode
� Recommended for draft or interim prints and proofreading only
� Prints at 600 x 600 dpi

Plain paper:
� 30 ppm color 
� 37 ppm black-and-white
Specialty papers:
� 10 ppm color 
� 15 ppm black-and-white
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TekColor� color corrections
You can select a color correction to match particular press specifications or match your computer 
screen�s colors. Otherwise, select Automatic to let the printer automatically pick the best color 
correction for elements in your document.  

Specify the color correction in a supported driver:

� Windows 95 / Windows 98/Windows Me PostScript driver: 
On the TekColor tab, select the desired color correction. Some of the color corrections are 
grouped under Office Color or Press Match Color.

� Windows NT / Windows 2000 / Windows XP PostScript driver: 
On the TekColor tab, select the desired color correction. Some of the color corrections are 
grouped under Office Color or Press Match Color.

� MMacOS 8 / MacOS 9 driver: 
In the Print dialog box, click on General, select TekColor from the pull-down menu, then select 
the desired correction for Color.

� MacOS X (version 10.1 and higher) driver: 
In the Print dialog box, select the Printer Features pull-down menu, then select the Print 
Quality/Color tab. Select the desired mode for Color Correction.

Note

When one of the color toner cartridges runs out while printing, you can cancel the color print 
job and resubmit it as a Black and White print job.

Color correction Description
Automatic      � Automatically optimizes the color correction for each element (text, graphics, and 

photographs) on the page.
sRGB Display   � Closely approximates the colors on a standard display screen.
sRGB Vivid   � Produces the brightest possible colors.
None � Does not use a color correction so the colors you specified in the application for 

your job are not altered.
� Use when you have specified colors from the Phaser® 7300 PANTONE® Color 

Chart, available at www.xerox.com.
SWOP Press   � Matches U.S. press standards using the Specification for Web Offset 

Publications.
Euroscale Press � Emulates the Euroscale 4-color process press mode.
Commercial Press   � Emulates a 4-color process commercial press mode. Use this selection for general 

4-color process Process PANTONE® Color matching. 
SNAP Press    � Matches the standards for printing on uncoated and newsprint papers using the 

Specifications for Non-heat Advertising Printing.
Black and White    � Produces a black-and-white version of a document.

� Colors converted to grayscale.
� Use to print page masters for photocopying in black-and-white.
� Use when one of the color toner cartridges is empty.

Use Printer Front Panel 
Setting

� Use the color correction set in the printer.
� The color correction can be set in the printer using the front panel or using 

CentreWare (if available).

http://www.xerox.com
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Secure prints, proof prints, and saved prints
These features are available if your printer has a Xerox printer hard drive. Choose one of the following 
special job types:

� Secure Print: Print confidential documents; your 4-digit numeric password-protected jobs are 
stored on the printer�s hard disk drive. The jobs print only after you enter the 4-digit number on the 
printer's front panel.

� Proof Print: Print only one copy of a multiple copy job so you can proof the copy. To print the 
remaining copies, select the job name on the printer's front panel. If you do not want the remaining 
copies, delete the job at the front panel.

� Saved Print: Store the job on the printer�s hard disk so you can print it on demand. The job is not 
deleted after printing. This is useful for requisition forms or any document you frequently print, 
such as tax forms, personnel forms, or requisition forms.

Note

These jobs are stored on the hard drive and remain in the printer even when it is powered off. 
There is a limit of 100 jobs on the hard drive, per type. When the printer reaches the limit, it 
deletes the oldest job per type automatically before adding a new one.

Printing secure print, proof print, and saved print jobs

Use a supported driver to specify a job as a secure print, proof print, or saved print job:

� Windows 95 / Windows 98 / Windows Me PostScript driver:
On the Setup tab, choose the job type. For a secure print job, enter a 4-digit password to assign to 
this job. For proof prints and saved prints, enter the name you want to give this job.

� Windows NT / Windows 2000 / Windows XP PostScript driver:
On the Output Options tab, choose the job type. For a secure print job, enter a 4-digit password  
to assign to this job. For proof print and saved print jobs, enter the name you want to give this job.

� MacOS 8 / MacOS 9 driver:
In the Print dialog box, select the Job Type pull-down menu, then choose the job type. For a 
secure print job, enter a 4-digit password to assign to this job. For proof print and saved print job, 
enter the name you want to give this job.

� MacOS X driver: 
In the Print dialog box, select the Printer Features pull-down menu, then select the Job Type  
tab. Select the desired Job Type and enter a 4-digit identifier. 

To print your secure print jobs, specify the 4-digit password on the printer's front panel:

1. With Menus highlighted, scroll to the Printable Pages Menu using the Down Arrow key 
and press the OK key.

2. Scroll to Secure Print Jobs and press the OK key.

3. Scroll to the correct first digit of the password.
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Note

If you entered less than four digits in the driver�s Password field, enter zeros before your 
password so that there are four digits entered in the front panel. For example, if you entered 
222 in the driver, enter 0222 in the front panel. You can use the Back Key to move back to 
a previous digit. All jobs with this numeric password will print after you press the OK key 
for the fourth digit.

4. Press the OK key.

5. Repeat steps 3 and 4 for the second, third, and fourth digits. 

To print a saved print job or the remaining copies of a proof print job, select the job name on the 
printer's front panel:

1. With Menus highlighted, scroll to the Printable Pages Menu  using the Down Arrow key.

2. Press the OK key.

3. Scroll to Proof Print Jobs or Saved Print Jobs.

4. Press the OK key.

5. Scroll until you find your job name. They are arranged alphabetically.

6. Press the OK key.

7. Scroll to Print and Delete or Print and Save.

8. Press the OK key.

9. Scroll to the desired number of copies.

10. Press the OK key to print the job. If your job is a proof job, it is automatically deleted after being 
printed.

To delete a saved print job or the remaining copies of a proof print job, select the job name on the 
printer's front panel:

1. With Menus highlighted, scroll to the Printable Pages Menu using the Down Arrow key.

2. Press the OK key.

3. Scroll to Proof Print Jobs or Saved Print Jobs.

4. Press the OK key.

5. Scroll until you find your job name. They are arranged alphabetically.

6. Press the OK key.

7. Scroll to Delete.

8. Press the OK key to delete the job.
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Separation pages
You can have the printer insert a separation page (a divider page or slipsheet) after a print job, between 
copies of a print job, or between individual pages of a print job. You can also specify the tray to use as 
the source for the separation pages.

To specify separation pages in a supported driver:

� Windows 95 / Windows 98 / Windows Me PostScript driver:
On the Output Options tab, select the location of the separation pages and the tray source.

� Windows NT / Windows 2000 / Windows XP PostScript driver:
On the Output Options tab, select the location of the separation pages and the tray source.

� MacOS 8 / MacOS 9 driver: 
In the Print dialog box, select the Advanced Media Options pull-down menu, then select the 
location of the separation pages and the tray source. 

� MacOS X driver:
In the Print dialog box, select the Printer Features pull-down menu, then select the 
Advanced Options tab. Select Separation Pages. 

Printing multiple pages to a single sheet (N-up)
When printing a multiple-page document, you can choose to print more than one page on a single sheet 
of paper. You can choose to print one, two, four, six, nine, or 16 pages per sheet.

To print multiple sheets on a single piece of paper in a supported driver:

� Windows 95 / Windows 98 / Windows Me PostScript driver:
On the Setup tab, click the More Layout Options button, then choose the number of pages per 
sheet from the drop-down list. When you print more than one page on a sheet, you can also print a 
border around each page.

� Windows 2000 / Windows XP PostScript driver:
On the Layout tab, choose the number of pages per sheet from the drop-down list.

� Windows NT PostScript driver:
On the Advanced tab, under Document Options, select the desired Page Layout (N-up) Option.

� MacOS 8 / MacOS 9 driver:
In the Print dialog box, select the Layout pull-down menu, then select the number of pages per 
sheet.

� MacOS X driver: 
In the Print dialog box, select the Layout pull-down menu, then select a layout. 
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Booklet printing
If your printer has a duplex unit installed, you can print a document in the form of a small book. The 
driver automatically reduces each page image by 50 percent and prints two pages per sheet of paper. 
The pages are printed in the correct order so that you can fold and staple the pages to create a booklet.

Note

You can create booklets for any paper size that is supported for 2-sided (duplex) printing.

When you choose to print booklets, you can also specify the creep and gutter in the Windows 95 / 
Windows 98 / Windows Me driver.  The gutter is the horizontal distance from the fold to the page image 
(in points). The creep is the distance that page images are shifted inward (in 10ths of a point); this 
compensates for the thickness of the folded paper, which otherwise would cause the inner page images 
to shift slightly outward.

To select booklet printing in a supported Windows driver:

� Windows 95 / Windows 98 /Windows Me PostScript driver:
On the Setup tab, click More Layout Options, then check Print Booklet Style in the 
More Layout Options box. You can also specify the creep and gutter in this box.

� Windows 2000 / Windows XP PostScript driver:
On the Layout tab, choose Booklet from the Pages per Sheet drop-down list.

Note

There is no Macintosh printer driver support for this feature.

Gutter Creep

7300-58
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Negative and mirror images
You can print your pages as a negative image (reverses the light and dark areas in your printed image) 
and/or mirror image (flips images horizontally on pages when printed).

To select negative or mirror images in a supported driver:

� Windows 95 / Windows 98 / Windows Me PostScript driver:
On the Setup tab, click More Layout Options, then select Print as a Negative Image and/or 
Print as a Mirror Image. 

� Windows 2000 / Windows XP PostScript driver:
From the Layout tab, click Advanced. Under Document Options and PostScript Options, select 
either Yes or No for Mirrored Output.

� Windows NT driver:
From the Properties tab, select the Advanced tab. Under Document Options and PostScript 
Options, select either Yes or No for Mirrored Output and Negative Output.

� MacOS 8 / MacOS 9 driver: 
From the File menu, select Page Setup, choose PostScript Options from the pull-down menu, 
and then select Invert Image (to print a negative image) or Flip Horizontal (to print a mirror 
image).

Note

This feature is not supported in the MacOS X driver operating system.
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Scaling
You can reduce or enlarge your page images when they are printed. You select a scaling value between 
25 and 400 percent. The default is 100 percent.

Select scaling in a supported driver:

� Windows 95 / Windows 98 / Windows Me PostScript driver:
On the Setup tab, click More Layout Options, then specify the percentage to scale in the 
Percentage box. 

� Windows 2000 / Windows XP PostScript driver:
From the Layout tab, click Advanced. In the box under Graphic, select the desired percentage 
for Scaling.

� Windows NT PostScript driver:
From the Properties tab, select Advanced. Under Graphic, select the desired percentage for 
Scaling.

� MacOS 8 / MacOS 9 / MacOS X driver: 
From the File menu, select Page Setup and then specify the percentage in the box after Scale

.

7300-7950% 100% 200%
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Auto Fit
When the printer uses a paper size that is different from the size specified in your driver, the Auto Fit 
feature enlarges or reduces the print image to fit the paper size it prints on. If this feature is turned off 
and the paper is not the same size as the print image, only a portion of the image will print, or the whole 
image prints on only a portion of the paper. 

The default value for this feature is on. You can turn off Auto Fit in a supported driver:

� Windows 95 / Windows 98 / Windows Me PostScript driver:
On the Setup tab, click More Layout Options, then clear Auto Fit.

� Windows NT / Windows 2000 / Windows XP Post Script driver:
On the Print/Quality tab, select Off for Auto Fit.

� MacOS 8 / MacOS 9 driver:
In the Print dialog box, select the Advanced Media Options pull-down menu, then select 
whether to have Auto Fit on or off.

� MacOS X driver: 
In the Print dialog box, select the Printer Features pull-down menu, then select the 
Advanced Options tab. Select whether to have Auto Fit On or Off. 

Watermarks
A watermark is text (independent of that provided by the printing application) that is printed on the first 
page or every page of the document. For example, terms like Draft, Confidential, Date, Version, that 
you might stamp on a paper before distribution, can be inserted with a watermark.

You can create a watermark or edit an existing watermark�s text, color, location, and angle. Using 
Windows drivers, you can also choose to print the watermark only on the first page, print the watermark 
in the background, or print the text of the watermark as an outline (instead of filled text).

Note

Not all applications support watermark printing.

To select, create, and edit watermarks using a supported Windows driver: 

� Windows 95 / Windows 98 / Windows Me PostScript driver:
On the Setup tab, click More Layout Options and then click Watermark to display the 
Watermarks dialog box. 

� Windows 2000 / Windows XP PostScript driver:
From the Layout tab, click Advanced. In the box under Document Options and 
Printer Features. Click Modify, then select the desired watermark in the Modify Watermarks 
dialog box.

Note

There is no Macintosh printer driver support for this feature.
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Image smoothing
Image smoothing blends adjacent colors in low-resolution images for smoother color transitions. For 
example, use image smoothing to improve the appearance of a 72 dpi image downloaded from the 
world wide web. Image smoothing is not recommended for 300 dpi or higher resolution images.

To select image smoothing in a supported driver:

� Windows 95 / Windows 98 / Windows Me PostScript driver:
On the Setup tab, click More Layout Options, then click Image Smoothing checkbox.

� Windows 2000 / Windows XP Post Script driver:
From the Layout tab, click Advanced. In the box under Document Options and 
Printer Features, select either On or Off for Image Smoothing.

� Windows NT driver:
On the Advanced tab under Printer Features, select either On or Off for Image Smoothing.

� MacOS 8 / MacOS 9 driver:
In the Print dialog box, select the Advanced Options pull-down menu, then select whether to 
have Image Smoothing on or off.

� MacOS X driver: 
In the Print dialog box, select the Printer Features pull-down menu, then selectwhether to have 
Image Smoothing on or off.
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Custom size paper
In addition to the wide variety of paper sizes available for this printer, you can use non-supported paper 
sizes for all paper types. Tray 1 and the Multi-Purpose Tray for this printer can hold custom size paper. 
The Multi-Purpose Tray can print on paper up to 36 inches long.  

To print on custom size paper:

1. Load the paper in a tray or in the Multi-Purpose Tray. 

2. Enter the dimensions of the paper on the printer�s front panel. For more information, see the Trays 
section of the Trays and Paper Guide on the Interactive Documentation CD-ROM.

3. Select the custom size in the printer driver.

Selecting custom sizes in the printer driver
� Windows 95 / Windows 98 / Windows Me PostScript driver:

On the Setup tab:

� If you select a specific tray and the tray displays Custom to indicate that it has custom size 
paper, enter the dimensions of the custom size paper in the Width and Height boxes.

� If you select Automatic for the paper source and select Custom Size for the paper size, enter 
the width and height values of the desired custom size paper in the Width and Height boxes. 
The values for width and height are initially 0. If you previously entered information in the 
boxes, the values are automatically entered.

� If a tray has paper with the width and height values you entered, the job is printed on that 
paper. If a tray doesn�t have paper with the values, it prompts you to load that paper.

� Windows NT / Windows 2000 / Windows XP PostScript driver:
On the Paper/Quality tab: 

� If you select Choose Specific Tray, you can select the tray containing the custom size paper.

� If you select Automatic, you can select your custom size from the Paper Size drop down 
list.

� Click My Custom Sizes and highlight the custom size in the Current Selection list. The 
Name, Width, and Height boxes display the details about the highlighted custom size and 
the sample image changes to represent a scaled version of the custom size.

7300-82
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� To create a new custom size:

� The My Custom Sizes box lists existing custom sizes that are supported by the current 
printer. Since these custom sizes are saved in your computer�s operating system, they are 
available for you to select in your applications.

� If you create a custom size in certain applications, the driver lists the custom size 
automatically.

� MacOS 8 / MacOS 9 driver:
In the Page Setup dialog box, select the Custom Page Sizes pull-down menu, then press New to 
enter a new custom page size. A dialog box appears where you can enter the width and height, 
margins, and name of the custom page size.

� MacOS X driver:
MacOS X driver currently does not support custom page sizes.

Cover pages
A cover page is the first or last page of a document. This printer allows you to choose a different paper 
source for the cover than for the body of a document. For instance, you can use your company 
letterhead for the first page of a document. You can also use card stock for the first and last pages of a 
report.

� You can use any paper tray as the source for cover pages.

� Make sure that the cover page is the same size as the paper used for the rest of your pages. If you 
specify a different size in the driver than the tray you select as a cover pages source, your cover(s) 
print on the same paper as the rest of your document.

� If you select both 2-sided printing and cover pages in the driver and your paper source for the 
covers does not support 2-sided printing (for example, the Multi-Purpose Tray), your document 
will print with cover pages, but it will print 1-sided. For more information, see the 
Specialty Printing section in the Trays and Papers Guide on the Interactive Documentation 
CD-ROM.

Cover page choices 

� None - Prints the first and last pages of your document using the same paper as the rest of your 
document.

� First Page Only - Prints the first page of your document from a different tray than the rest. 

� First and Last Pages - Prints the first and last pages of your document from a different tray than 
the rest. 

1. Click New.

2. Enter the new name in the Name box.

3. Enter the dimensions in the Width and Height boxes. The sample image changes to 
represent a scaled version of the new custom size. 

4. Click Save to add the new size to the list. Click Cancel to exit without saving the 
new custom size.

5. To exit, click Close. 
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If you select First Page Only or First and Last and you select 2-sided printing, the first two pages of 
the job prints on the front cover.

If you select First and Last Pages and you select 2-sided printing, both the first and last two pages (for 
a document with an even number of pages) of the job print on the front and back cover pages.

Note

For a blank back cover, you must include a blank last page in your document.

Selecting cover pages

To turn this feature on in the driver:

� Windows 95 / Windows 98 / Windows Me PostScript driver: 
On the Output Options tab, select First Page Only or First and Last Pages, then select the 
tray to use for the covers from the Source drop-down list. 

� Windows NT / Windows 2000 / Windows XP PostScript driver:
On the Paper/Quality tab under Cover Pages , select First Page Only or First & Last 
Page, then select the tray to use for the covers from the Source drop-down list.

� MacOS 8 / MacOS 9 driver:
Select the General pane in the Print dialog box, then select either All pages From or both 
First Page From and Remaining From. These choices display a list of paper trays in the 
printer. Additionally, in the Advanced Options pane, select Last Page Paper Source to see 
a list of trays.

� MacOS X driver: 
Select the Paper Feed pane in the Print dialog box, then select either All pages From or 
both First Page From and Remaining From. These choices display a list of paper trays in 
the printer. Additionally, in the Advanced Options pane, select Last Page Paper Source to 
see a list of trays. 
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Printer Features
Printing the Startup Page    

By default the printer produces a Startup Page each time the printer is turned on or reset. You can 
disable the automatic printing of the Startup Page as shown here and later print it from the Printable 
Pages menu.

There are two methods for turning on/off the Startup Page:

� Adjust from the printer�s front panel.

� Use CentreWare Internet Serivces (IS) software.

To turn on/off the automatic printing of the Startup Page from the printer�s front panel:

1. With Menus highlighted, press the OK key.

2. Scroll to Printer Setup Menu using the Up Arrow or Down Arrow key and press the 
OK key.

3. Scroll to Startup Page. The end of the line also displays the setting (On or Off).

4. To change the setting, press the OK key.

To turn on/off the automatic printing of the Startup Page using CentreWare IS software:

1. From your printer�s Internet Services home page, click Properties.

2. On the left side of the Properties page in CentreWare IS, click Printer Defaults.

3. If desired, change the setting for Print Startup Page (under User Preferences on the Printer 
Defaults page).

4. Click the Save Changes button on the bottom of the page.

To print the Starup Page at the front panel: 

1. Scroll to the Printable Pages Menu using the Down Arrow or Up Arrow key and press the 
OK key.

2. Scroll to the Print Startup Page using the Down Arrow or Up Arrow key and press the 
OK key to print.
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Power saver
The printer enters a Power Saver low-energy consumption mode after a predefined period of time since 
its last activity. In this mode, most printer electrical systems are shut down. When a print job is sent to 
the printer, it wakes up the printer in less than a minute. You can also wake the printer by pressing the 
OK key on the front panel.

If you find that the printer is going into Power Saver mode too often and you do not want to wait while 
the printer wakes up, you can extend the length of time before the printer goes into Power Saver mode. 
Change the timeout on the front panel as follows:

1. With Menus highlighted, press the OK key.

2. Scroll through the menu to Printer Setup Menu using the Down Arrow key and press the 
OK key.

3. Scroll through the menu to Set Power Saver Timeout using the Down Arrow key and 
press the OK key.

4. Select a Power Saver timeout value. Select a higher value if you want to extend the length of time 
before the printer goes into Power Saver mode.

5. Press the OK key.

To turn off the Power Saver feature, use the following procedure:

1. With Menus highlighted, press the OK key.

2. Scroll through the menu to the Printer Setup Menu and press the OK key.

3. Scroll to the Reset Printer Menu using the Down Arrow key and press the OK key.

4. Scroll through the menu to Power Saver using the Down Arrow key. 

5. Press the OK key to turn off.

Protected mode for the front panel menus      
You can put the printer into �protected mode� to prevent users from changing printer settings that may 
impact the prints of other users from the front panel. Instead, users can select printing features, such as 
color corrections, through the printer drivers only. In protected mode, users can access general menus 
that can improve their print quality and direct them to user features, while locking the menus and items 
in menus that the system administrator uses to manage the printer.

To enter or exit protected mode, use CentreWare IS software:

1. From your printer�s Internet Services home page, click Properties.

2. On the left side of the Properties page in CentreWare IS, click Printer Defaults.

3. If desired, change the setting for Front Panel Menus (under User Preferences on the 
Printer Defaults page).

� Select Off to have all menus available. 

� Select On to lock all menu items that change printer setup values.

4. Click Save Changes on the bottom of the page.
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Load paper timeout
When you select either Auto Select or a paper type as paper sources,  but the printer does not have the 
selected type and size loaded, the front panel prompts you to load the type and size required in the 
Multi-Purpose Tray. If you do not load the requested paper within the load paper timeout, the printer 
picks paper from the default tray.

To change the load paper timeout from the printer�s front panel:

1. With Menus highlighted, press the OK key.

2. Scroll to Printer Setup Menu by pressing the Up Arrow or Down Arrow key.

3. Press the OK key.

4. Scroll to Set Load Paper Timeout.

5. Press the OK key.

6. Scroll through the list of values until your desired timeout appears. The values (0, 1, 3, 5, or 
10 minutes, 1 or 24 hours), indicate the length of time you want the printer to wait for you to 
load paper before printing. If you select a value of 0, the printer does not wait for paper to be 
inserted and uses the paper in the default tray immediately. 

7. Press the OK key.

To change the load paper timeout using CentreWare IS software:

1. From your printer�s Internet Services home page, click Properties.

2. On the left side of the Properties page in CentreWare IS, click Printer Defaults.

3. The setting for Load Paper Timeout is under Timeout Settings on the Printer Defaults page. 
Select one of the following choices: 0, 1, 3, 5, or 10 minutes, 1 or 24 hours; if you select a value of 
0, the printer times out immediately. 

4. Click the Save Changes button on the bottom of the page.

Front panel intensity
To make the front panel text more readable, you can adjust the intensity of the front panel�s background 
lighting:

1. On the front panel, with Menus highlighted, press the OK key.

2. Scroll to Printer Setup Menu by pressing the Up Arrow or Down Arrow key.

3. Press the OK key.

4. Scroll to Set Front Panel Intensity. 

5. Press the OK key.

6. Scroll until the desired front panel intensity is displayed. The intensity values range from 
0 (no back ground light) to 10 (brightest background light).

7. Press the OK key.
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Front panel contrast
To make the front panel text more readable, you can adjust the contrast between the text and the 
background:

1. On the front panel, with Menus highlighted, press the OK key.

2. Scroll to Printer Setup Menu by pressing the Up Arrow or Down Arrow key.

3. Press the OK key.

4. Scroll to Set Front Panel Contrast. 

5. Press the OK key.

6. Scroll the value until you achieve the desired contrast between the text and the background. The 
values range from 1 to 10.

7. Press the OK key.

Intelligent Ready mode
Intelligent Ready mode is an automated system that monitors the printer�s usage and warms up the 
printer when you are most likely to need it and puts it into Power Saver mode when you use it the least.

To turn Intelligent Ready mode on or off from the printer�s front panel:

1. With Menus highlighted, press the OK key.

2. Scroll through the menu to Printer Setup Menu using the Up Arrow or Down Arrow keys.

3. Press the OK key.

4. Scroll through the menu to Intelligent Ready using the Up Arrow or Down Arrow keys.

To change the setting, press the OK key.

To select Intelligent Ready mode or schedule warmup/standby settings using CentreWare IS 
software:

1. From your printer�s Internet Services home page, click Properties.

2. On the left side of the Properties page in CentreWare IS, click Warmup.

3. For Warmup Mode, select either Intelligent Ready or Scheduled (if you want to specify the 
warmup/standby settings for each day).

4. If you selected Scheduled in step 3, make selections for each day�s warmup setting and standby 
setting.

5. Click the Save Changes button on the bottom of the page.

Note

Although the front panel selections only enable you to turn Intelligent Ready mode on or off, 
CentreWare IS enables you to specify particular printer warmup times.
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Front panel language
To change the language used for the text on the front panel, CentreWare IS, and the printable pages:

1. On the front panel, with Menus highlighted, press the OK key.

2. Scroll to Printer Setup Menu by pressing the Up Arrow or Down Arrow key and press the 
OK key.

3. Scroll to Set Front Panel Language and press the OK key.

4. Scroll to the desired language and press the OK key.
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Fonts
Your printer uses the following types of fonts:

� Resident fonts

� Fonts downloaded onto the printer�s optional hard drive

� Fonts downloaded into printer memory

� Fonts downloaded with your print job from the application

ATM (Adobe Type Manager) software helps your computer display these fonts on your computer 
screen as they will appear in your prints. If you don�t already have ATM on your computer, install it 
from the printer�s CD-ROM. Also, install the printer�s screen fonts for your computer from the ATM 
folder.

Resident typefaces (PostScript)
Printer-resident fonts are always available for printing. All printer configurations are shipped with 
136 PostScript resident Roman fonts plus the Central and Eastern European encoding for many of the 
fonts. You can print a sample of the resident PostScript fonts at the front panel.

Resident Roman typefaces and their Central European equivalents   
AdobeSansMM
AdobeSerifMM
AlbertusMT
AlbertusMT-Italic
AlbertusMT-Light
AntiqueOlive-Bold
AntiqueOlive-Compact
AntiqueOlive-Italic
AntiqueOlive-Roman
Apple-Chancery
ArialMT
Arial-BoldItalicMT
Arial-BoldMT
Arial-ItalicMT
AvantGarde-Book
AvantGarde-BookOblique
AvantGarde-Demi
AvantGarde-DemiOblique
Bodoni
Bodoni-Bold
Bodoni-BoldItalic
Bodoni-Italic
Bodoni-Poster
Bodoni-PosterCompressed
Bookman-Demi
Bookman-DemiItalic
Bookman-Light
Bookman-LightItalic

AntiqueOliveCE-Bold
AntiqueOliveCE-Compact
AntiqueOliveCE-Italic
AntiqueOliveCE-Roman
Apple-ChanceryCE
ArialCE
ArialCE-Bold
ArialCE-BoldItalic
ArialCE-Italic
AvantGardeCE-Book
AvantGardeCE-BookOblique
AvantGardeCE-Demi
AvantGardeCE-DemiOblique
BodoniCE
BodoniCE-Bold
BodoniCE-BoldItalic
BodoniCE-Italic
BodoniCE-Poster
BodoniCE-PosterCompressed
BookmanCE-Demi
BookmanCE-DemiItalic
BookmanCE-Light
BookmanCE-LightItalic
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Carta
Chicago
Clarendon
Clarendon-Bold
Clarendon-Light
CooperBlack
CooperBlack-Italic
Copperplate-ThirtyThreeBC
Copperplate-ThirtyTwoBC
Coronet-Regular
Courier
Courier-Bold
Courier-BoldOblique
Courier-Oblique
Eurostile
Eurostile-Bold
Eurostile-BoldExtendedTwo
Eurostile-ExtendedTwo
Geneva
GillSans
GillSans-Bold
GillSans-BoldCondensed
GillSans-BoldItalic
GillSans-Condensed
GillSans-ExtraBold
GillSans-Italic
GillSans-Light
GillSans-LightItalic
Goudy
Goudy-Bold
Goudy-BoldItalic
Goudy-ExtraBold
Goudy-Italic
Helvetica
Helvetica-Bold
Helvetica-BoldOblique
Helvetica-Condensed
Helvetica-Condensed-Bold
Helvetica-Condensed-BoldObl
Helvetica-Condensed-Oblique
Helvetica-Narrow
Helvetica-Narrow-Bold
Helvetica-Narrow-BoldOblique
Helvetica-Narrow-Oblique
Helvetica-Oblique
HoeflerText-Black
HoeflerText-BlackItalic
HoeflerText-Italic
HoeflerText-Ornaments
HoeflerText-Regular
JoannaMT
JoannaMT-Bold
JoannaMT-BoldItalic
JoannaMT-Italic
LetterGothic
LetterGothic-Bold
LetterGothic-BoldSlanted
LetterGothic-Slanted

ChicagoCE
ClarendonCE
ClarendonCE-Bold
ClarendonCE-Light

CoronetCE-Regular
CourierCE
CourierCE-Bold
CourierCE-BoldOblique
CourierCE-Oblique
EurostileCE
EurostileCE-Bold
EurostileCE-BoldExtendedTwo
EurostileCE-ExtendedTwo
GenevaCE
GillSansCE-Bold
GillSansCE-BoldCondensed
GillSansCE-BoldItalic
GillSansCE-Condensed
GillSansCE-ExtraBold
GillSansCE-Italic
GillSansCE-Light
GillSansCE-LightItalic
GillSansCE-Roman

HelveticaCE
HelveticaCE-Bold
HelveticaCE-BoldOblique
HelveticaCE-Cond
HelveticaCE-CondBold
HelveticaCE-CondBoldObl
HelveticaCE-CondObl
HelveticaCE-Narrow
HelveticaCE-NarrowBold
HelveticaCE-NarrowBoldOblique
HelveticaCE-NarrowOblique
HelveticaCE-Oblique
HoeflerTextCE-Black
HoeflerTextCE-BlackItalic
HoeflerTextCE-Italic
HoeflerTextCE-Regular

JoannaMTCE
JoannaMTCE-Bold
JoannaMTCE-BoldItalic
JoannaMTCE-Italic
LetterGothicCE
LetterGothicCE-Bold
LetterGothicCE-BoldSlanted
LetterGothicCE-Slanted

Resident Roman typefaces and their Central European equivalents   
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LubalinGraph-Book
LubalinGraph-BookOblique
LubalinGraph-Demi
LubalinGraph-DemiOblique
Marigold
MonaLisa-Recut
Monaco
NewCenturySchlbk-Bold
NewCenturySchlbk-BoldItalic
NewCenturySchlbk-Italic
NewCenturySchlbk-Roman
NewYork
NotDefFont
Optima
Optima-Bold
Optima-BoldItalic
Optima-Italic
Oxford
Palatino-Bold
Palatino-BoldItalic
Palatino-Italic
Palatino-Roman
StempelGaramond-Bold
StempelGaramond-BoldItalic
StempelGaramond-Italic
StempelGaramond-Roman
Symbol
Tekton
Times-Bold
Times-BoldItalic
Times-Italic
Times-Roman
TimesNewRomanPS-BoldItalicMT
TimesNewRomanPS-BoldMT
TimesNewRomanPS-ItalicMT
TimesNewRomanPSMT
Univers
Univers-Bold
Univers-BoldExt
Univers-BoldExtObl
Univers-BoldOblique
Univers-Condensed
Univers-CondensedBold
Univers-CondensedBoldOblique
Univers-CondensedOblique
Univers-Extended
Univers-ExtendedObl
Univers-Light
Univers-LightOblique
Univers-Oblique
Wingdings-Regular
ZapfChancery-MediumItalic
ZapfDingbats

LubalinGraphCE-Book
LubalinGraphCE-BookOblique
LubalinGraphCE-Demi
LubalinGraphCE-DemiOblique

MonacoCE
NewCenturySchlbkCE-Bold
NewCenturySchlbkCE-BoldItalic
NewCenturySchlbkCE-Italic
NewCenturySchlbkCE-Roman
NewYorkCE

OptimaCE-Bold
OptimaCE-BoldItalic
OptimaCE-Italic
OptimaCE-Roman

PalatinoCE-Bold
PalatinoCE-BoldItalic
PalatinoCE-Italic
PalatinoCE-Roman
StempelGaramondCE-Bold
StempelGaramondCE-BoldItalic
StempelGaramondCE-Italic
StempelGaramondCE-Roman

TimesCE-Bold
TimesCE-BoldItalic
TimesCE-Italic
TimesCE-Roman
TimesNewRomanCE
TimesNewRomanCE-Bold
TimesNewRomanCE-BoldItalic
TimesNewRomanCE-Italic
UniversCE-Bold
UniversCE-BoldExt
UniversCE-BoldExtObl
UniversCE-BoldOblique
UniversCE-Condensed
UniversCE-CondensedBold
UniversCE-CondensedBoldOblique
UniversCE-CondensedOblique
UniversCE-Extended
UniversCE-ExtendedObl
UniversCE-Light
UniversCE-LightOblique
UniversCE-Medium
UniversCE-Oblique

ZapfChanceryCE-MediumItalic

Resident Roman typefaces and their Central European equivalents   
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Resident typefaces (PCL5c)
For PCL5c printing, the printer includes Courier, Times, and Universe typefaces in medium, bold, italic 
medium, and italic bold and others for a total of 46 resident PCL fonts. 

Resident PCL typefaces 

Downloading fonts    
To supplement the resident fonts (which are always available for printing), downloadable fonts can be 
sent from your computer and be stored in the printer�s memory or on the printer�s optional hard drive. 
Adding more printer memory expands the number of fonts that can be stored in your printer�s memory 
at once. See the Supplies section in the Support Guide on the Interactive Documentation CD-ROM or 
log on to www.xerox.com/officeprinting/7300supplies for part numbers of the memory.

Note

If you turn the printer off, the fonts you download are wiped out. You must download them 
again when you turn the printer on again.

Before printing, make sure that the fonts specified in your document are installed in the printer or are set 
up to download correctly. If you request a font in an application that is not resident in the printer, is not 
correctly installed, or is not downloaded from the application sending the print job, the text is printed in 
the most recently used resident typeface.

AlbertusE-ExtraBold
AlbertusE-Medium
AntiqueOliveE-Bold
AntiqueOliveE-Italic
AntiqueOliveE-Regular
ArialE
ArialE-Bold
ArialE-BoldItalic
ArialE-Italic
ClarendonE-Condensed
CoronetE
CourierE-Bold
CourierE-BoldItalic
CourierE-Italic
CourierE-Regular
GaramondE-Antiqua
GaramondE-Halbfett
GaramondE-Kursiv
GaramondE-KursivHalbfett
LetterGothicE-Bold
LetterGothicE-Italic
LetterGothicE-Regular
Line Printer

MarigoldE
OptimaE-Bold
OptimaE-BoldItalic
OptimaE-Italic
OptimaE-Regular
SymbolE
TimesE-Bold
TimesE-BoldItalic
TimesE-Italic
TimesE-Roman
TimesNewRomanE
TimesNewRomanE-Bold
TimesNewRomanE-BoldItalic
TimesNewRomanE-Italic
UniversE-Bold
UniversE-BoldCondensed
UniversE-BoldCondensedItalic
UniversE-BoldItalic
UniversE-Condensed
UniversE-CondensedItalic
UniversE-Italic
UniversE-Medium
Wingdings

http://www.xerox.com/officeprinting/7300supplies
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The printer accepts the following (and other) downloadable fonts:

� Type 1

� Type 3 

� Adobe

� Agfa

� Bitstream

� Microsoft

� Apple

� TrueType (scalable to any point size; looks the same on-screen and printed).

Downloading fonts from a Macintosh  
Use the Apple Printer Utility to download fonts to the printer.

Note

In order to download the fonts to the printer with the Apple Printer Utility, the job must be 
disabled on the printer�s front panel.

1. If you don�t already have the Apple Printer Utility on your computer, install it from the printer�s 
CD-ROM. 

2. Start the Apple Printer Utility by double-clicking the icon (in the PhaserTools folder on your 
computer�s hard disk).

3. In the Printer Selector dialog box:

a. Under AppleTalk Zones, select your printer�s zone.

b. Under Printers, select your printer.

c. Click the Open Printer button.

4. In the printer�s dialog box, click the arrow next to Printer Preferences.

5. Click the arrow next to Fonts to display the list of installed fonts and their locations.

6. Click Add.

7. In the dialog box, select the folder containing the font you want to download, select the font, and 
click Add. The font is listed as ready to download.

Note

To add all of the fonts in the folder to the list of fonts to download, click the Add All button. 
If you decide not to download a font, highlight the font in the list of fonts to download and 
click the Remove button.
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8. For Destination, select the download location: either the printer�s memory or the hard disk.

9. To download the fonts in the list, click the Send button.

Note

To remove downloaded fonts from the printer, follow steps 2 through 5, highlight the font in 
the list under Fonts (in the printer�s dialog box), and then click the Remove button.

Downloading fonts from a PC  
To list the fonts available on the printer, use the font download utility on the Xerox web site at: 
www.xerox.com/officeprinting/support.

Printing a sample of resident fonts   
Listing the fonts from a Macintosh  

Use the Apple Printer Utility to list the fonts available on the printer.

Note

In order to send the list of fonts to the printer with the Apple Printer Utility, you must disable 
this on the printer�s front panel.

1. If you don�t already have the Apple Printer Utility on your computer, install it from the printer�s 
CD-ROM. 

2. Start the Apple Printer Utility by double-clicking the icon (in the PhaserTools folder on your 
computer�s hard disk).

3. In the Printer Selector dialog box:

a. Under AppleTalk Zones, select your printer�s zone.

b. Under Printers, select your Phaser 7300 Color Printer.

c. Click Open Printer.

4. From the File menu, select Print Font Samples.

Listing the fonts from a PC  

To list the fonts available on the printer, use the font download utility on the Xerox web site at 
www.xerox.com/officeprinting/support.


www.xerox.com/officeprinting/support
www.xerox.com/officeprinting/support
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Listing the fonts from your printer�s front panel

You can print both a PCL font list and a PostScript font list from the front panel:

1. On the front panel, with Menus highlighted, press the OK key.

2. Scroll to Printable Pages Menu by pressing the Up Arrow or Down Arrow key and press 
the OK key.

3. Scroll to either Print PostScript Font List or to Print PCL Font List and 
press the OK key.

Listing the fonts from CentreWare IS

You can print font samples from CentreWare IS if you have a hard drive on your printer.

1. Enter the printer�s IP address in your browser to open CentreWare IS.

2. Click the Print tab.

3. Click Print Fonts to display the Print Font Samples screen.

4. Select either PostScript or PCL fonts. You can only select one at a time.

5. Click the button to start to print.



Copyright © 2002 Xerox Corporation. All Rights Reserved. 34

Index
Numerics
1650-sheet high-capacity feeder 4
550-sheet feeder 4

A
auto fit 17
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B
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booklet printing 14

C
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downloading fonts 30
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driver 17�21
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font sampler, Macintosh utility file 32
fonts

CentreWare IS 33
downloading 30
printing a list of resident fonts 32
sampler, printing 32
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front cover release
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adjusting contrast 25
adjusting light intensity 24
displaying errors 7
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menus 23

front panel contrast 25
fuser

location 3

I
information on front panel 7
intelligent ready mode 25

L
left side output tray

location 2

M
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font sampler 32
magenta imaging unit
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print quality 9
multiple pages to a single sheet 13
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Index

O
optional paper trays 4
output tray

location 1

P
parallel connector

location 2
PC fonts 32
PCL typefaces 30
PostScript fonts on a PC 32
power cord receptacle

location 2
print quality modes 9
printer

front panel menus 23
quality modes 9

printer components 5
printing tips

menu map 7
proof prints 11

Q
quality modes 9

S
saved prints 11
scaling 16
secure prints 11
separation pages 13
setting

front panel contrast 25
front panel intensity 24

side output tray
location 2

SNAP Press
color correction 10

sRGB Display color correction 10
sRGB Vivid Color

color correction 10
standard mode 9
Startup Page

enable or disable 22
SWOP Press color correction 10

T
TekColor color corrections 10
top cover

location 1
top output tray

location 1, 2
transfer unit

location 3
transparencies

modes 9
Tray 1

location 1
TrueType fonts 30
typefaces

central European 27
resident PCL5c 30
resident PostScript 27

U
USB connector 2

W
watermarks 17
web sites

ordering options 5
supplies 30
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